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1 INFORMATION BEFORE USING SPECTRAPEN DEVICE

Read this manual carefully before operating the device. If you are not sure about something in the manual, contact the manufacturer for
clarification.

By accepting the device, the customer agrees to follow the instructions in this guide.

Always follow corresponding manuals while working with the SpetraPen device or doing the maintenance.
It is forbidden to interfere with the hardware or software of the SpetraPen device in any way without previous agreement with the
manufacturer.

The following table presents basic highlight symbols used in this manual:

Symbol Normal Style - Description

Important information, read carefully.

Complementary and additional information.

Tab. 1 Used symbols.

2 GENERAL DESCRIPTION

SpectraPen SP 110 is a handheld portable spectroradiometer that is ideal as a general-purpose instrument for research and for
agricultural applications. SpectraPen is especially useful for rapid measurements of solar irradiance and monitoring of spectral light
quality. External light source and sample holder enable to use SpectraPen also for measurements of absorption, reflectance,
transmittance, emission, color and fluorescence of various samples.

Li-lon rechargeable battery, splash-proof case and integrated GPS module make SpectraPen an ideal tool for environmental, agricultural
and ecological applications such as monitoring of artificial lighting used in horticulture industry or light source testing. Spectrum of
measured light source is instantly displayed on the SpectraPen touch screen. All recorded data are automatically stored into the device
internal memory. The SpectraPen also includes a comprehensive software package comprising full system control, data acquisition and
data processing.

SpectraPen measures:

Scope —rough light spectrum

Transmittance — calculated using the following formula
T=1/lp

Where: |y is reference light intensity

| is measured light intensity

Absorbance - calculated using the following formula
A=log (lo/1)

Where: |y is reference light intensity

| is measured light intensity

Users defined formulas in SpectraPen software

Page | 4



PHOTON
SYSTEMS
INSTRUMENTS

SpectraPen versions:

SP 110 UVIS Wavelength range from 340 to 790 nm

SP 110 NIR Wavelength range from 640 to 1050 nm

2.1 TECHNICAL SPECIFICATION

340 nm —790 nm (SP 110 UVIS)

Spectral range
640 nm — 1,050 nm (SP 110 NIR)

9 nm (SP 110 UVIS)

Spectral response half width
8 nm (SP 110 NIR)

Wavelength reproducibility | +/- 0.5 nm

Spectral Straylight -30dB
Integration time From5msto 10s
Number of pixels 256

High gain: 1:4300

Dynamic range .
Low gain: 1:13000

Optical entrance SMA905 to 0.22 numerical aperture single-stand optical fiber

Internal memory capacity Up to 16 Mbit

Internal data logging Up to 4,000 measurements
Data transfer USB cable
PC software SpectraPen 1.1 (Windows 7 and higher)
Battery type Li-lon rechargeable battery
Battery capacity 2,600 mAh
Max. charging current 0.5A
Charging Via USB port - PC, power bank, USB charger, etc.
Battery life 48 hours typical with full operation
Low battery indicator
Display Touchscreen 240 x 320 pixel; 65,535 colors

Ultra-high sensitivity down to -165dBm
High accuracy of <1.5 m in 50% of trials

Built in GPS module

Size 150 x 75 x 40 mm

Weight 300¢g

. . Temperature: 0 to +55 °C
Operating conditions . » .
Relative humidity: 0 to 95 % (non-condensing)

. Temperature: -10 to +60 °C
Storage conditions . o .
Relative humidity: 0 to 95 % (non-condensing)

Warranty 1 year parts and labor
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3 DEVICE DESCRIPTION

SMA9O05 fiber
optic connector

Color touch
screen display

Power button

Connector for USB cable

Textile strap holder

Fig. 1 Device description.

3.1 LIST OF EQUIPMENT AND CUSTOMER INFORMATION

Standard version of the SpectraPen device package consists:

SpectraPen SP 110

Carrying Case

Textile Strap for Comfortable Wearing

SpectraPen Operating Manual (on a USB flash disc)

SpectraPen software and driver (on a USB flash disc)

USB cable

Stylus

Other Accessories or Optional Features (according to your specific order)

For data download via USB connection, the USB driver needs to be installed on the PC. It can be found on the
installation disk (USB driver folder).

If any item is missing, please, contact the manufacturer. Also check the carton for any visible external damage. If any
damage is found, notify the carrier and the manufacturer immediately. The carton and all packing materials should be
retained for inspection by the carrier or insurer.

For customer support, please write to: support@psi.cz

Page | 6


mailto:support@psi.cz

e Never submerge the device in water!

e The device should not come in contact with any organic solvents, strong acids or bases.

e Keep the optical sensor cover clean and dry. If cleaning is needed, use soft, non-abrasive tissue.
e Do not use sharp objects for touch screen operation.

It is recommended to re-calibrate the device by the manufacturer every 2 years.

e Avoid fully discharging of the battery.

e Do not keep the battery at full charge for long periods of time. Allow for it to discharge.

e High temperatures shorten battery life.

e If the battery can no longer be charged, please contact PSI for replacement battery and installation instructions.

Switch on the device by pressing the Power button and follow next steps to perform the measurements. In case the device battery is
not charged connect the SpectraPen to the PC or to USB adaptor (not included) via the USB cable and charge the battery.

(Fig. 2-A)
e Get spectrum - measure and save the spectrum to the device internal memory.
e Integration time - move the slider to set measuring time.

(Fig. 2-B)
e Scope —rough spectrum data
e Absorbance — calculated data
e Transmittance — calculated data

Measure Device Data Options Help 1L 1| [EERNed Device Data Options Help 1]

400 450 520 560 640 100 760 40 400 460 520 550 640 100 160
‘Wavelength[nm] I Wavelength[nm]
Integration time: [9100 [ms] Integration time: [0100 [ms]

Get Spectrum E D """""" IB Get Spectrum Elj i m

Fig. 2 A) Main display B) Measure menu.




For absorbance and transmittance calculation a reference needs to be obtained first. Measure light source without
the sample in the optical path as a reference.

(Fig. 3)

e Preview — if checked, spectrophotometer continuously measures and displays current data, data is stored only after Get Spectrum
button is pressed.

e High Gain — if checked, high sensitivity mode is enabled.

e Auto Sensitivity — if checked, integration time and gain is set automatically to reach optimal signal/noise ratio.

e Get Dark Current — check to get dark current. After that, dark current is automatically subtracted from measured data.

e Get Reference — check to get reference spectrum without the sample in the optical path. A reference needs to be obtained for
absorbance or transmittance measurements.

Measure Daka Options Help 1
Presiew :
High Gain

Auko Sensitivity
Get Dark Current |

Gek Reference

400 460 520 530 G40 70O 7RO

Wavelength[nm] |
Inkegration time: 0100 [ms]

ek Spectrum E I:l m

Fig. 3 Device menu.

e Browse (Fig. 4)—- displays data browse dialog box. The user can browse the list of stored data, select the set of data files and view the
light spectra in Scope, Absorbance or Transmittance mode. Color classification of each data file helps the user to discriminate
between individual measurements.

Measure Device [BELEN O 1 Measure Device Data Options Help (I

Browse

Erase :
‘ Scupel Absorbancel Transmitance |
#| Tme | Date | 2
00:00:00  0.0.2000 [v
0 0 =]
0 ‘ . =
340 400 460 520 580 640 700 160
Wavelength[nm]
Integration time: [0100 [ms] W | gk | | Cancel I

Get Spectrum E D E m ¥

Fig. 4 Browse data.

e Erase — use this to erase internal data memory
e Memory info (Fig. 5) — displays info on currently used memory



Measure Device Data Options Help

0 of 2097152 Bytes

i}
340 400 460 520 580 640 70O T60
Wavelength[nm]

Inkeqration time: [0100 [msI

Get Spectrum ED----------.EI

Fig. 5 Memory info.

e Settings—this function is used to set various variable for the light measurements and for the device operation
o Graph (Fig. 6-A) — displays options for setting the wavelength range and graph features
= Zoom enable — enables the zoom feature. With the stylus select an area (in the right-down direction) of the displayed graph
which you want to zoom in. Reverse these steps if you want to return to the original display.
= Marker enable — enables display of the numeric coordinates of the point touched on the graphical display (in the right hand
corner).
= Autoscale - enables the auto scale of the y-axis. The Y axis is automatically adjusted according to measured values.
= Smoothing — enables noise reduction of the graphical display by Smoothing the noise in the spectrum at the expense of
spectral resolution.
= Wavelength range — defines the range of wavelengths. Desired wavelength range can be adjusted by selecting the
wavelength and by using the arrows up and down.
o Time (Fig. 6-B)- displays actual time and date (all data files are stored by time and date signature). To change time and/or date
specifications touch on one of the values and adjust it using the arrows.

Measure Device Data Options Help 1 Measure Device Data Options Help (|

o settings | o settngs |

Graphl Tirnel LCD I Devicel 55 Graphl Timel LCD] Devicel

50 -
- Zoomenable [ -
. Marker enable [~ sof | Time: [10:[03 :[H
35 Autoscale [ oo |E|
= Smoothing [ 30 E|
25 o
a0f | Wavelength range - Date: W . lﬁ | 18

il o e o] :

10 10

2 5

[ ok | [ cancel | [ ok | [ cancal |

Integration time: [0100 [ms] Integration time: 0100 [ms]

Get Spectrum ED"""""'E Get Spectrum ED"""-----E

Fig. 6 A) Settings — Graph B) Settings - Time.

o LCD (Fig. 7-A)—is used to adjust LCD display control settings.
= Backlight intensity — move slider to adjust back light intensity in percentage
= Backlight time-out — move slider to adjust backlight time-out between 5 and 60 s (time of inactivity required before backlight
will dim out to save battery life).
o Device (Fig. 7-B)
= GPS-—activates the GPS built-in module. The GPS coordinates cannot be displayed on the device display, but they are exported
together with data and visualized in SpectraPen software on the computer after download.



= Average —Average function is used for adjusting the number of scans for each reading. Averaging of more scans results in a
higher signal-to-noise ratio but increases the time required for each reading that appears on the screen. Move slider to set
the number of measurement to be acquired for averaged values.

Fig. 7 A) Settings — LCD B) Settings - Device.

Help
e About - information about the device, hardware and software version.

SpectraPen  SPTO/UVIS
hvy ver . 4
SWW Ver. 26

(c) 2008-2022 PSI
WY RSICZ

Fig. 8 About.
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5 PCCOMMUNICATION

5.1 USB CONNECTION

SpectraPen comes with the USB cable that is required for charging of the Li-ion battery and can also be used for data transfer to the PC
after completion of measurements. To connect the USB cable with the SpectraPen device follow the picture instructions below. Please
note that a lock in system is used to secure the USB cable to the SpectraPen and extreme caution has to be used when setting up this
connection to avoid damage to the cable pins.

When connecting the USB cable take extra caution to prevent damage to the cable connector pins. Ensure
correct orientation of the cable as shown in the pictures below so the circled portion of the plug and the cable in
photo A and B are perfectly lined up prior to pushing them together. Once this connection is achieved the cable
may be secured in position by turning the metal cover of the cable and locking the cable in position.

To connect SpetraPen with your computer please follow steps below in Fig. 9:

Fig. 9 How to connect SpectraPen with PC.

A) connector on the SpectraPen device. B) Portion of the USB cable with pins. C — E) Position the cable horizontally and line up the green circled parts
of the cable and the connector, plug in the inlet and screw the securing screw. F) Correct connection of the USB cable and Pen device.
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5.2 DRIVER INSTALLATION

For successful USB connection of the SpectraPen to the PC computer the USB driver and the SpectraPen software, included on the USB
disk, need to be first installed on the PC. Without the driver installed the SpectraPen device will not be recognized by the computer and
the connection to the software will be not possible.

e Press Start and Select Control Panels (Fig. 10)

A N , E
OO [+ controtpanel » ~ [43 ][ Search Controt Panel )
Adjust your computer's settings Viewby: Category ¥
System and Security User Accounts and Family Safety
Review your computer's status & Add or remove user accounts
Back up your computer W Set up parental controls for any user
Find and fix problems e
. Appearance and Personalization
_Network and Internet % Change the theme
t! View network status and tasks Change desktop background
S&®.,  Choose homegroup and sharing options Adjust screen resolution
Hardware and Sound Clock, Language, and Region
View devices and printers 5
Adas dadci : Change keyboards or other input methods
P Ease of Access
rograms Let Windows suggest settings
5 Uninstall 3 program Optimize visual display

Fig. 10 Control panel.

e Navigate through System and security, System to Device manager (Fig. 11)

q System
View amount of RAM and processor speed | Check the Wi

Q Allow remote access | See the name of this computer 9 Device Manager

Fig. 11 System window.
e Connect the SpectraPen to the PC. You should see that PSI USB Device appears in the list. Right click on it and select Update Driver
Software (Fig. 12).

|* i INELWUTE dUdpILET

4 E} Other devices

|l PSIUSB Device

. B Portable Dev|  Update Driver Software...

475 Ports (COM Disable
T Commun
YZ' USB Seria
— USE Seria Scan for hardware changes
[+ ' Processors

f} ﬂ Sound, vided Properties
&g Systern devices

Fig. 12 PSI USB device.
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e Click Browse my computer for driver software and select Driver folder on the SpectraPen installation disk. Allow the installation even
if the warning message appears (Fig. 13)

4 o SN-SP-037 (G:)
4 | Software

3 F- -
How do you want to search for driver software? L Driver
| User Guide

() L Updete DriverSoftware - PSI USB Device

# Search automatically for updated driver software
will search your puter and the Internet for the latest driver software
for your device, unless you've disabled this feature in your device installation
settings.

% Browse my computer for driver software
Locate and install driver software manually.

Fig. 13 Choose the driver from the USB disc.
@ Il Update Driver Software - PSIUSB Device
Windows has successfully updated your driver software
Windows has finished installing the driver software for this device:
PSIUSE Device

Fig. 14 Complete installation.

Installation of the driver is now complete (Fig. 14)

In case this driver installation is not successful the driver may be downloaded directly from PSI websites www.psi.cz.

Once the device is properly connected to the computer, the indicating icon appears on the SpectraPen device display Fig. 15.

- Data Help

Fig. 15 Icon on the SpectraPen device display indicating the proper USB connection.
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6 SPECTRAPEN SOFTWARE

6.1 SOFTWARE INSTALLATION

1. Copy the SpectraPen software provided on the USB flash disk to your computer and launch the SpectraPen program.

2. To connect and recognize the SpectraPen device in the SpectraPen software, proceeds first with the registration of the SpectraPen
software (Fig. 16).

e Select: Help > Register

e Enter: your serial registration number (found in a text file on the USB flash disk drive included with the device).

e Select: OK

File Device Setup | Help

l Registration I 1

About

Online Commands

Registration =]

inputyourcode: |

[ Regster | [ Cancel |

Fig. 16 Software registration.

Please note that the serial (registration) number for the SpectraPen may be found in the file SN.txt, which is
included on the enclosed USB flash disk.
Please Note: it is not possible to download data from the SpectraPen device without software registration.

3. Connect the USB cable to the computer. Then switch on the SpectraPen by pressing the Power button for a couple of seconds.
4. Ensure the PC and the SpetraPen are properly paired (see chapter 5).
5. Connect SpectraPen device in SpectraPen software, Device > Connect (Fig. 17)

File | Device | Setup Help

~§  Connect A—

Update Firmware
Attach GPS File

Dowi

Memory Erase

Online Control

el

Save

0

BExport

Device: Not Connected Version |

Fig. 17 SW connection.
6. When the device is properly connected the left bottom corner of the SW window will display “SpectraPen” (Fig. 18). Otherwise
notification “Device: Not Connected” is displayed (Fig. 19).
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File Device Setup Help

Download

Open

Save

Export

| SpectraPen | | 1301 1049 of 2007152 bytes used

Fig. 18 SpectraPen connected.

File Device Setup Help

Download

Device: Not Connected | Version

Fig. 19 SpectraPen not connected.

Page | 15




6.2 SOFTWARE MENU

MENU: File
Load

Save

Export

Export to JSON
Close

Close All

Exit

MENU: Device
Connect

Update Firmware
Attach GPS File
Memory Erase

Online Control

Loads previously saved data files.

Saves data to hard disc.

Exports data in .txt format.

Exports data in JavaScript Object Notation.
Closes the current experiment.

Closes all open experiments.

Exits the program.

Detects and connects the device.

Used for firmware updates. *

Used to download data from the GPS module of the old version of the

SpectraPen - LM 500.
Erases data from the SpectraPen memory.

Online control of SP device.

* For more information on firmware updating, see Chapter 6.5 of this Operation Manual.

MENU: Setup
Update Software

Settings

MENU: Help
Registration

About

Page | 16

Used for software updates.

On/Off — Auto memory erase after download.

Selection of separator for the csv file after its export and
following opening in Excel (TAB, SEMICOLON, COMMA, SPACE).

Used for the SpectraPen software registration.

Offers basic information about the program.

File | Device Setup Help

Load
Save
Export
Export

Close

Close All

Exit

J150MN

Fig. 20 Menu File.

File

Connect

Update Firmware
Attach GPS File
Memory Erase

Online Control

Device | Setup Help

Fig. 21 Menu Device.

File  Device | Setup | Help
Update Software
Settings
Fig. 22 Menu Setup.
(@ SpectraPen
File Device Setup | Help | IR

Registration
About

Fig. 23 Menu Help.



PHOTON
SYSTEMS
INSTRUMENTS

6.3 DATA TRANSFER AND VISUALIZATION

N

After completion of measurement SpectraPen may be connected to PC for data download and further analysis.

Launch the SpectraPen software on the computer and Connect the device. Go to Device> Connect.

To transfer your data from the SpectraPen device to your PC use the Download function. Select icon on left side of screen or go to
File and select Load if you want to process data stored on PC.

4. All data stored currently in the SpectraPen device will be downloaded and shown in the main window view. The data are store and
displayed/listed with the time stamp of measurement.
Please note that if there are no data stored in the memory, the download function is not active.
5. Visualization modes: Scope mode window is always displayed as the default. To view calculated spectrum go to Absorbance or

Transmittance tab (Fig. 24).

Data type menu Selection of shown data
Data download from
SpectraPen @ SpectraPen - o x
File Device Setup H
Opening of data from ¥ Soore [tme [ Tomaas \.
local disc Download 1 2401202285011
50000 =00 Ef 2 2401202290125
\ 3 24.01.20229:01:38
. Open 8 4 2401.20229:01:47
Data saving in .spec format A5 22m2029ms3
. [ 24,01.2022 5:02:09
7 24012022 9:02:19
Save Hlle  za0foz290235
Data export in .txt format —
\ Export
b

6285 7285 8285 9285 10285
[nm]

Measure Data
SpectraPen | 1301 | 52700f 2097152 bytes used |

List of measured data

Fig. 24 Scope spectra.

6.

All data that are downloaded are displayed in the Scope window after download from the SpectraPen. The user can select the set of
measurements to be displayed by marking and unmarking the data from the selection list (Fig. 24).

Right click on list of measured data enables edit data name, delete selected measurement or show and hide all measured data in
the graph— Select all measure and Clear all measure (Fig. 25).
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Fig. 25 Options for list of data.

File Device Setup Help
Scope | Absorbance | Transmiance
30000 A 1".'. 7\ 7] Clear all measure
Open 25000 I \ '1 / \ \ "‘ \l \ % Edit measure name
20000 | '.] / , \\ \ i ii \ @I Delete measure _I
- \ | 1R
= Wi O
10000 ",‘ '}! A -
e st ANY/ZSRN
0- (S, "7 o |
'5000324 4é4 524 624 724
[nm]
Measure Data I
SpectraPen | 1301 | 6294 of 2097152 bytes used

8. In the graph marker feature is available, which enables display of the numeric values for wavelength for the selected wavelength of
the scan (Fig. 26). Use the mouse to select the given point. In top right corner of the graph (green rectangle) is displayed exact value
for the selected point on the x-axis and y-axis.

Device

Setup Help

Scope | Absorbance | Transmeance

16000

12000

1 1742015101701 ~
2 174205109721
3 1742015101742
4 1742015101808
5 1742015100832
6 1742015101843
7 1742015101931 |
8 1742015101945
9 1742015102014
10 1742015102029
N 1742015102054
1742015102116 |
1742015102146
1742015 102203
1742015102222
174201510224
1742015 102315
1742015102331
1742015102353
20 1742015102602
21 1742015102450
1742015 102500
1742015 102514
1742015102525
1742015102551
1742015 102616
1742015102632
1742015102658
1742015102718
1742015102732
1742015102747
17.4.2015 102757
1742015102812
1742015102821
1742015 102836
1742015 102849
1742015 102905
17.4.2015 102916
1742015102933
1742015102942
1962015 153225

"JH&E?¥

N OE N I O O -
R )
m,

SZBYURBLBRUBUBNRRREN

e [ [ o T o o foe T oo T i o T o Fu fo o o oo o oo o o T i o s o e o o i oo e J 0|

-

C\Usens\L

Device: Not

Connected | Version

Fig. 26 Marker feature.

Page | 18




9. To zoom in on the data displayed in the graph select an area of the displayed graph (Fig. 27). To reverse these steps and return to
original display use minus icon in the corners of the zoom area marked with red rectangles in Fig. 27.
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(@ SpectraPen - m] X
File Device Setup Help
Scope  |radiance
\ [ >» | M@ 1 03072018 11:21:22
X489 Ml 2 03.07.2018 11:23:.02
v=1063 N3 03.07201811:2314
5 HMB 4 03072018 11:28:34
M5 09.082018823:10
MB 6  09.08.20188:23:45
M 7 09.0820188:23:56
Save “l s 09.082018824:10
M 9 09.0820188:24:19
&l 10 0908201882452
M 11 09.08.2018 8:25:01
90 MM 12 09.08.2018 8:25:26
13 09.08.2018 8:26:07
[nm]
C:\Users\Katerina\Desktop \test-data-ND spec
Device: Not Connected | Version |
Fig. 27 Zoom function.
10. To view calculated values, use double arrow in the top right corner (Fig. 28, in red rectangle).
@ SpectraPen = () X
File Device Setup Help
Scope Absorbance Transmitance
Download F 1 2401.2022901:11
60000 > m 2 2401.2022901:25
3 2401.20229.01:38
Open 4 24.01.20229:01:47
5 2401.20229:01:59
6 24.01.20229.02:09
40000 B 7 240120290219
Save Ml 2401202290236
P
Export 2
o N
-20000
628.5 7285 828.5 928.5 1028.5
[nm]
Measure Data
SpectraPen | 1301 | 52700f 2097152 bytes used

Fig. 28 Numerical values calculated from spectra.
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Please note that SP 110 does not have default predefined calculations from the manufacturer. The user can create
formulas based on own requirements. For more information please see chapter 10.1

11. To Save the experiment select File>Save. All data stored in the device memory will be saved irrespective of the data selection in the
SpectraPen software. The file will be stored as .spec. Spec files stores all Scope data.

12. Select File>Export to export the data in .txt format. Export function allows the user to specify the type of data. The options are:

e Spectrum (Fig. 29) — all raw scope data for entire range of measured wavelengths.
Spectrum scope — scope data normalized to dark spectrum scan are exported for all acquired scans or set of selected
measurements.

Export (=] ]

What

@ Spectrum

() Spectum Scope

(") Spectrum Transmitance
(7) Spectrum Absorbance

Spectrum Imadiance

Flazsh Merazure
(7) Computed Data
Export Interpolation
| Bpot || Cancel |

Fig. 29 Export table.

e Spectrum Transmittance — transmittance data for all measurements are exported.

e Spectrum Absorbance — absorbance data for all measurement are exported.

e Computed Data (Fig. 30) — export of the calculated values from Scope, Transmittance or Absorbance spectra of all of the
measurements. SP 110 does not contain default formulas for calculated values. This feature exports calculations based on user’s
predefined formulas. More in chapter 10.1.

e Export interpolation —interpolated data are read every 1 nm, they are the same such as raw data.

Export - O >
What
() Spectrum
() Spectrum Scope
() Spectrum Transmitance Choose Values
i) Spectrum Absorbance [v] Scope
() Spectrum Iradiance [ Transmitance
i) Flash Merasure [] Absorbance
(@) Computed Data Iradiance
[] Export Interpolation

Fig. 30 Export of computed values.
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6.4 ONLINE CONTROL

Menu Online Control

This function can be used for remote - online control of the SpectraPen device after connection with the PC. Online control enables to
make changes in device setting and also perform remote measurement using PC.

Select: Menu > Device > Online Control (Fig. 31)

File | Device | Setup Help

Connect

Update Firmware
Attach GPS File

Memory Erase

Online Control

Fig. 31 Online control.

Remote measurement (Fig. 32)
Using this function Scope, Absorbance and Transmittance can be measured.

e  For manual remote measurement click on Get button.

e  Setting for automated remote measurement is possible using the button with three dots (next to “Get” button in the window of
the software). Here the time interval of the measurement is set. To apply this setting use the option Use settings and confirm by
clicking OK. The measurement stars immediately and continues until it is manually stopped (Stop button).

e  Use the export option for exporting the data to .csv file.

e  Clear function serves for erasing of data measured by Online Control

Parameters measured

using online control Erasing of online
measured data
Manual remote ~ # SpectrePen - o x
measurement e D= Sp BES
SWDG Absorbance TM@ Sdﬁ"
HE’.-
Setting of automated
Measure dark current oen remote measurement
.,
Save
Expart
Export of online Erasing of online
measured data measured data
e o
| @Gexr |
Measure Data Online Corirol
SpectraPen | 1304 5270 of 2007152 bytes used |

Fig. 32 Remote measurement.
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Settings (Fig. 33)
Here the following functions may be set up for remote operation of the SpectraPen:
e Time synchronization of the device and PC
e GPS built-in module activation (more information about the GPS module in chapter 7)
e  Averaging of measurement (1 — 10 measurements)

e Integration time (0—105s)

# SpectraPen

File  Device

Setup  Help

Scope Absobance Tramsmitance Settings

Time synchronization

[ sme |

Save

SpectraPen |

Device time:10:05:34
01.24.2022

PC time:10:05:34
01.24.2022

GPS
[] enable

Integration timefms] Average

Measure Data  Orline Control

1.3.01

Fig. 33 Online control settings.

6.5 FIRMWARE UPDATE

and save!

5270 of 2097152 bytes used

All data in the SpectraPen memory are erased during the firmware update!
Before starting any firmware update, download all your data from the SpectraPen memory to the computer

Before firmware update ask the manufacturer for appropriate version of the firmware for your particular device.
Incompatible firmware version can cause device malfunction.

Starting Update
Selecting .bxn file

Select: Open.
Finishing Upload

.._UJ.._N).!—\

Select: Setup > Update Firmware from File

Find firmware update file: Binary file (with the extension .bxn)

Select: OK to start uploading of the update
The bottom bar indicates the upload progress (Fig. 34)

SpectraPen-Boot

0 of 2097152 bytes used

Fig. 34 Firmware update running.
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SpectraPen device SP 110 has integrated GPS module which may be turned on during the measurement for mapping of the collected
data to specific field position. When GPS module is turned on, the map coordinates will be automatically saved with all collected data
and will be downloaded during data download.

For proper GPS reading, the time in your SpectraPen and in your computer must be synchronized. Preset time and
time zone must correspond to GPS time (time zone) in your location.

1. Check the time setting on the SpectraPen device: Settings > Date & Time

2. Switch the GPS module “ON” on the SpectraPen device by following these steps in the SpectraPen menu:

e Select: Options > Settings > Device

e Click on the check box for GPS (Fig. 35 - A)

e Wait until the GPS position is found. The GPS is ready when the icon of the position flag, in upper menu, stops flashing (Fig. 35-B).

Device Data Options Help (8 .Jeasure Data Options Help g (|
Settings ‘
Indexes | Graph [ Time [ LcD | Device |
Grs: v £
o
£
=5
Average: [0z 3
‘T
4 ;
5
3
2
i 340 420 500 580 660 740
OK I | Cancel I Wavelength{nm]
Get Reflectance X N Get Spectrum Get Dark Spectrum

Fig. 35 A) Activation of GPS B) GPS active.

For proper function of the GPS the SpectraPen device may need a clear view of the sky to acquire satellite signal.

3. Perform the selected measurements
4. Connect the SpectraPen to the computer and open the SpectraPen software to proceed with download of the measured data. Data
measured with activated GPS module are downloaded with GPS coordinates (Fig. 36).



(@# SpectraPen

File Device Setup Help |
Scope  Iradiance *

Download Index Time Name Gps O 91 25012019 11:18:0¢ A

- . OW 92 25012019 11:18:1¢
105 18.02.2019 11:54:41 49" 20.2454'N 16" 285012 E
- - O 93 25012019 11:18:4:
106 18.02.2019 11:54:58 49° 20.2448'N 16° 2849%4'E [ 94 2501201911:18:5¢
Open 107 18.02.2019 11:55:09 497202448 N 16" 284994'E Of 95 12022019 14:57:0:
O

[f 97 12022019 15:37:3
Save COf 98 12022019 15:37:4¢
Ol 99 12022019 15:41:2¢
[0 100 12022019 15:42:3;
O 101 14022019 11:57:5¢
Expot Il 102 14022019 12:08:2¢
[ 103 14022019 13:30.07
OB 104 14.02.2019 13:30:4¢
105 18.02.2019 11:54:41
10 106 18.02.2019 11:54:5¢

107 18.02.2019 1155:0¢ v
< >

Measure Data
SpectraPen | 1301 112270 of 2097152 bytes used |

Fig. 36 Data with GPS coordinates.
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8 WARRANTY TERMS AND CONDITIONS

e This Limited Warranty applies only to the SpectraPen device. It is valid for one year from the date of shipment.

o If at any time within this warranty period the instrument does not function as warranted, return it and the manufacturer will repair
or replace it at no charge. The customer is responsible for shipping and insurance charges (for the full product value) to PSI. The
manufacturer is responsible for shipping and insurance on return of the instrument to the customer.

e No warranty will apply to any instrument that has been (i) modified, altered, or repaired by persons unauthorized by the
manufacturer; (ii) subjected to misuse, negligence, or accident; (iii) connected, installed, adjusted, or used otherwise than in
accordance with the instructions supplied by the manufacturer.

e The warranty is return-to-base only and does not include on-site repair charges such as labor, travel, or other expenses associated
with the repair or installation of replacement parts at the customer's site.

e The manufacturer repairs or replaces faulty instruments as quickly as possible; the maximum time is one month.

e The manufacturer will keep spare parts or their adequate substitutes for a period of at least five years.

e Returned instruments must be packaged sufficiently so as not to assume any transit damage. If damage is caused due to insufficient
packaging, the instrument will be treated as an out-of-warranty repair and charged as such.

e PSlalso offers out-of-warranty repairs. These are usually returned to the customer on a cash-on-delivery basis.

e Wear & Tear Items (such as sealing, tubing, padding, etc.) are excluded from this warranty. The term Wear & Tear denotes the
damage that naturally and inevitably occurs as a result of normal use or aging even when an item is used competently and with
care and proper maintenance.

9 TROUBLESHOOTING AND CUSTOMER SUPPORT

In case of problems with the SpectraPen visit FAQ on our websites (hitp://psi.cz/support/fag) or contact customer support by email to
support@psi.cz, or contact your local distributor.
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10 APPENDIX

10.1 PROGRAMMING CUSTOM INDEX IN SPECTRAPEN

The SpectraPen software enables programming custom indexes, which can be used for wide range of calculation based on the measured
spectrum.

1. Go to the main SpectraPen folder in your PC (Usually in Program Files).

2. Open the file Config > Formulas.txt.

3. Write your index into this .txt file and save it (Fig. 37).

e Index example:

e Scope:PSlindex:PSI test index:Scope[600nm]/ Scope[500nm]

e Scope —the index is placed in the bookmark Scope in data in the software

e PSlindex — name of the index in the SpectraPen software and in exported data

e PS| test index — full name of the index (not showed)

e Scope[600nm]/ Scope[500nm] — equation for calculation; calculated from 500 and 600 nm of Scope spectra

Formulas - Paznamkavy blak - [a} B
Soubor Upravy Formét Zobrazeni Napovéda

Transmitance:NDVI:Normalized Difference Vegetation Index:(Transmitance[78@nm]-Transmitance[63@nm])/(Transmitance[78@nm]+Transmitance[63@nm]) ~

Transmitance:SR:Simple Ratio Index:Transmitance[788nm]/Transmitance[63@nm]

Transmitance:MCARI1:Modified Chlorophyll Absorption Ratio Index 1:1.2%(2.5*(Transmitance[78@nm]-Transmitance[678nm])-1.3*(Transmitance[78@nm]-Transmitance[558nm]))
Transmitance:0SAVI:Optimized Soil-Adjusted Vegetation Index:(1+8.16)*(Transmitance[788nm]-Transmitance[67@nm])/(Transmitance[788nm]+Transmitance[676nm]+8.16)
Transmitance:G:Greenness Index:Transmitance[S554nm]/Transmitance[677nm]

Transmitance:MCARI:Modified Chlorophyll Absorption Ratio Index:((Transmitance[7@@nm]-Transmitance[67@nm])-@.2*(Transmitance[78@nm]-Transmitance[55@nm]))*(Transmitance
[7eenm]/Transmitance[67@nm])

Transmitance:TCARI:Transformed CAR Index:3*((Transmitance[7@@nm]-Transmitance[670nm])-8.2*(Transmitance[7@@nm]+Transmitance[55@nm])*(Transmitance[708nm]/Transmitance
[67enm]))

Transmitance:TVI:Triangular Vegetation Index:8.5*(120*(Transmitance[75@nm]-Transmitance[55@nm])-20@*(Transmitance[678nm]-Transmitance[55@nm]))
Transmitance:ZMI:Zarco-Tejada & Miller Index:Transmitance[75@nm]/Transmitance[716nm]

Transmitance:SPRI:Simple Ratio Pigment Index:Transmitance[43@nm]/Transmitance[686nm]

Transmitance:NPQI:Normalized Phaecphytinization Index:(Transmitance[415nm]-Transmitance[435nm])/(Transmitance[415nm]+Transmitance[435nm])
Transmitance:PRI:Photochemical Reflectance Index:(Transmitance[531nm]-Transmitance[578nm])/(Transmitance[531nm]+Transmitance[578nm])
Transmitance:NPCI:MNormalized Pigment Chlorophyll Index:(Transmitance[68@nm]-Transmitance[438nm])/(Transmitance[688nm]+Transmitance[4386nm])
Transmitance:Ctrl:Carter Indices 1:Transmitance[695nm]/Transmitance[42@nm]

Transmitance:Ctr2:Carter Indices 2:Transmitance[695nm]/Transmitance[76@nm]

Transmitance:Licl:Lichtenthaler Indices 1:(Transmitance[78@nm]-Transmitance[680nm])/(Transmitance[78@nm]+Transmitance[68@nm])

Transmitance:Llic2:Lichtenthaler Indices 2:Transmitance[448nm]/Transmitance[69@nm]

Transmitance:SIPI:Structure Intensive Pigment Index:(Transmitance[78@nm]-Transmitance[45@nm])/(Transmitance[78@nm]+Transmitance[658nm])
Transmitance:GM1:Gitelson and Merzlyak Indices 1:Transmitance[75@nm]/Transmitance[556nm]

Transmitance:GM2:Gitelson and Merzlyak Indices 2:Transmitance[75@nm]/Transmitance[7@enm]

Transmitance:ARI1:Anthocyanin Reflectance Index 1:1/Transmitance[558nm]-1/Transmitance[78@nm]

Transmitance:ARI2:Anthocyanin Reflectance Index 2:Transmitance[79@nm]*(1/Transmitance[55@nm]-1/Transmitance[7@@nm])

Transmitance:CRI1:Caroteniod Reflectance Index 1:1/Transmitance[51@nm]-1/Transmitance[55@0nm]

Transmitance:CRI2:Caroteniod Reflectance Index 2:1/Transmitance[51@nm]-1/Transmitance[7@@nm]

Transmitance:RDVI:Renormalized Difference Vegetation Index:(Transmitance[78@nm]-Transmitance[67@nm])/((Transmitance[780nm]+Transmitance[67@nm])"@.5)
Irradiance:LUX:LUX:683*integral(Irradiancel,360nm,780nm)

Irradiance:PAR[uUE]:PAR[uE]:integral(IrradianceE, 4@@nm, 788nm)

Irradiance:IRR[uk/em2] :Irradiance[ul/cm2]:integral(Irradiancel, 34@nm, 78@nm)

Lonadi 188 AIR LUl lcal e Tonadi [T diTogadianceW, 64@nm, 1850nm)

Scope:PSIindex:PSI test index:Scope[6@@nm]/ Scope[saenm]l

Fig. 37 New index in the Formulas file.
4. Restart the SpectraPen Software.

5. The new index appears in the selected bookmark in the data (Fig. 38).
6. For export of this index choose the option “Computed values” and selected spectrum in the export table.
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(@ SpectraPen - [m] X
File Device Setup Help |
Scope  |radiance *
- | Index Time Name PSlindex % 1 03.07.2018 11:21:22
Il 2  03.07.2018 11:23:02
03.07.2018 11:21:22 0.1398
3 03.07.201811:23:14
2 03.07.2018 11:23:02 0.1246 E 4 03.07.2018 11:28:34
: 3 03.07.2018 11:23:14 05444 5  09.08.20188:23:10
4 03.07.2018 11:28:34 06424 % : g.:ﬁ:: z:g:;g
Save 5 09.08.2018 8:23:10 0.5049 l 8 09.08.2012 8:24-10
6 09.08.2018 8:23:45 0.6869 M 9 09.08.20188:24:19
7 09.08.2018 8:23:56 10829 l 10 0308201882452
24 11 09.08.2018 8:25:01
Export 8 09.08.2018 8:24:10 1.1581 Gl 12 0308201882526
9 09.08.2018 8:24:19 0.8928 13 09.08.2018 8:26:07
10 09.08.2018 8:24:52 8.6956
n 09.08.2018 8:25:01 237136
12 09.08.2018 8:25:26 28,7221
13 09.08.2018 8:26:07 34643
C:\Users\Katerina\Desktop \test-data-ND spec
Device: Not Connected ‘ Version ‘

Fig. 38 New index.

Function description

Different mathematical functions can be used in SpectraPen software syntax to create new custom formulas.

min, max -
min(valuel, value2)
valuel - number, variable, function
value2 — number, variable, function
- only one value can be function!
min(array)
array — array of numbers

examplel: max(Scope)

example2: min(Irradiance)

example3: min(Scope[760nm], max(Scope[450], Scope[680]))
example4: max(Irradiance[550nm], (5+4)*4)

In —the natural (base e) logarithm of specified number
In(value)
value — number, variable, function

examplel: In(5)

example2: In(Irradiance[760nm])

example3: In(max(Irradiance [550nm], Irradiance[480nm]))
example4: In((5+4)*4)

log — the logarithm of specified number in a specified base.
logB(value)
B — base - number
value — number, variable, function

examplel: log2(5)

example2: log5(Scope[760nm])

example3: log10(max(Scope[550nm], Scope[480nm]))
exampled: log10((5+4)*4)
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sqrt —the square root of a specified number
sqrt(value)
value — number, variable, function

examplel: sqrt(5)

example2: sqrt(Scope[760nm])

example3: sqrt(max(Scope[550nm], Scope[480nm]))
exampled: sqrt(((5+4)*4) + 6)

A - specified number raised to the specified power
value*power
value — number, variable, function
power — number, variable, function

examplel: Irradiance[760nm]” Irradiance[550nm]
example2: min(lrradiance[760nm], Irradiance[550nm])*max(Irradiance[435nm], Irradiance[430nm])
example3: Transmitance[760nm]*0.5

integral - express the area under the curve of a graph of the function in the interval
integral(function_values, from, to)
function_values — input values for integral compute
from,to — limit values

examplel: integral(Irradiancel, 360nm, 700nm)
example2: integral(IrradianceE, 360nm, 700nm) * IrradianceE[450]
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